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2020 Deadlines, Judging, & Permissions
Deadlines

Unfortunately, due to the many Covid Challenges this year, our
End of Year Competition for 2020 will be DIGITAL ONLY. We are sorry, but
we will NOT be able to offer a PRINT COMPETITION this year.
ALL images must be submitted in digital (jpg) format by
Midnight on the third Saturday in October:
SATURDAY, OCTOBER 17, 2020 to Digital.CCRVA@gmail.com

Judging

Judging for the End of Year Competition will take place on November 14th. Three
top photography experts will judge our images in a Zoom event, facilitated by our
EOY Committee. Winners will be announced at the annual Awards Presentation
to be held on Wednesday, December 9, 2020 – virtually via Zoom.

Permissions By entering this competition, you agree to allow the publication/
display of your images on the CCR website, facebook page, and in
our monthly publication, “Southern Exposure”.

Evaluation & Judging Criteria
1. Overall Impact/
Impression

Does the image tell a “story” and is the subject of the image appropriate to
the story? Does the image evoke emotion? Does the image have a “wow”
factor?

2. Technical
Factors

Does the image display focus, depth of field, exposure, lighting, contrast, and
color balance (or tonal scale in black and white images) that are appropriate
to the subject matter and the “story” being told by the photographer?

3. Creativity

Is the photo original and fresh in composition and/or in the use of lighting,
perspective, color, special effects, etc.?

4. Composition

Is the design of the image visually pleasing or disturbing depending on the
intent of the photographer? Do the elements of the image hold the observer
and easily draw him/her to its subject? Does the composition come together
as a whole, providing balance or lack thereof as appropriate to subject matter
and the “story”?

5. Finishing

If present, do physical or digital mats, borders, vignetting, etc. add to the
photo or distract from it?

Remember that each Evaluator is expressing his or her own personal opinion and that
“Beauty is in the eye of the Beholder” – AND the Photographer!
Back to Table of Contents
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General Rules
The Camera Club of Richmond (CCR) offers six Image Evaluations to our members each year.
Members are invited to submit one or two digital images that will be reviewed and critiqued by a
seasoned/professional photographer during those designated monthly meetings (See CCR
Meeting Schedule for specific dates for Evaluations.)
CCR also holds an End of Year Competition and allows each member to enter up to TWELVE
images subject to these rules:
•

Images that are evaluated throughout the year are called Standard Images, and you may
enter any number - up to all twelve - into the EOY Competition.

•

Or, you may opt to substitute up to FIVE images into the EOY Competition that were NOT
evaluated during the year for FIVE Standard Images. These images are called Wildcards.

Photographers submitting images for the EOY Competition must be Camera Club of Richmond
Members in good standing, having paid the current year Membership Dues.
All submissions, camera work (including staging and post-production), as well as any “creative
changes” must be the work of the photographer submitting the image.
Images made while under the immediate direction or technical supervision of another person are
not eligible. For example, images made under the immediate direction of an instructor while
attending a photo outing, seminar, class, trip, or safari are not eligible.
An image may only be entered once into the EOY Competition. For instance, the image may not
be entered as both a B&W and a Color image or into different Categories.
Images may NOT include the photographer's name on the face of the image.
Back to Table of Contents
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Guidelines for Post-Processing
Photographers are encouraged to utilize the many tools we now have at our disposal to enhance their
images before submitting for Image Evaluations and the EOY Competition. However, in order to level
the playing field, each artist should adhere to the following guidelines in order to be considered in the
following categories:

•

Architecture

•

Flora

Images in these six “General” Categories may be
enhanced. However, post-processing must be kept to a
minimum and used only to enhance the existing image and
ensure realism, such as:

•

Landscape

•

•

Pictorial

• Tonal Changes

•

Portrait

• Sharpening

•

Wildlife

• Cloning (for minor retouching such as removal of
telephone wires or trash)

General Categories:

•

Special Categories
•

Assigned Subjects (3)

•

Creative Art

Exposure

Adjustments to contrast, sharpness, cropping, altering
horizontal and vertical axis, and enhancement (but not
changing) of overall color.

In the “Special” Categories (Creative Art and Assigned
Subjects), post-processing is unlimited.
These Categories are to show the creativity of the
photographer, as well as digital editing or darkroom skills
used to enhance the image.
Elements, such as clouds, plants, animals, people,
buildings, etc., from one or more images may be combined
into a single image.
Likewise, post-processing filters and creative imaging
software may be used. Images in this category will be
judged on their imagination, creativity, uniqueness, and
editing.

Back to Table of Contents
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Glossary of Important Terms
Assigned
Subjects

At the beginning of each year, the CCR Board announces three special
Categories referred to as “Assigned Subject” Categories for that year. The
intent is to challenge our photographers to try something new or stretch their
post processing skills (since these categories allow unlimited post-processing
creativity).

Black & White
Images
[BW]

The Color Designation BW refers to Black & White images. They are
monochrome images, including infrared photographs, produced in black and
white or in varying tones of only one color. Images that are primarily
monochrome but contain added color to part of the image should be
submitted as Color, NOT as B&W.

Camera Club of
Richmond
Member

A CCR Member is one who has paid Membership Dues for the current year.
All CCR Members are eligible to submit images for Image Evaluations (held
during monthly CCR Meetings) as well as participate in the End of Year
Competition.

Camera Club of
Richmond Dues

CCR dues for FULL membership in the club are $40.

Categories

These are the general groups to which you will submit your images for the
End of Year Competition. See the official Category list for guidance on
where to place your photos or contact any CCR Directors for help.

Color Designation

Color Designation refers to the range of colors contained in your image.

Please note: Membership in CCR MeetUp (MeetUp.com/Camera-Club-ofRichmond) is free, however if you only belong to CCRMeetUp, you are NOT
eligible to submit images for Image Evaluations or participate in the End of
Year Competition.

Black & White (B&W) images are monochrome images, including infrared
photographs, produced in black and white or in varying tones of only one
color. Images that are primarily monochrome but contain added color to part
of the image should be submitted as Color, NOT as B&W.
Color (C) refers to images shot in full color or containing any color other than
black and white.
Color Images
[C]

The Color Designation Color refers to images shot in full color or containing
any color other than black and white.

End of Year
Competition
EOY

CCR holds a competition at the end of each year and invites members to
submit up to 12 photographs to compete for awards in several different
Categories. Up to five of those photos may be Wildcard Images. The other
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images (called Standard Images) must have been evaluated at one of the
monthly CCR Image Evaluations during the current year.
These photos are due in October and judged by a panel of professional
photographers – usually from outside the Richmond area – in November.
Awards are presented at our CCR Awards Banquet which is held in place of
our regular CCR meeting on the second Wednesday in December.
EOY Groups

Group A (Seasoned Exhibitor)

[A]

Any member MAY enter images in the Group A competition.
You are REQUIRED to compete in Group A if you have won any Camera
Club of Richmond Memorial Award or have received more than 3 placed
awards (1st, 2nd or 3rd place).
Once you have competed in Group A, you must remain in this Group for all
future competitions.

[B]

Group B (Novice Exhibitor)
This group is for new/novice CCR Members.
In order to compete in this group, you must NOT have won any Camera Club
of Richmond Memorial Award or have received more than 3 placed awards
(1st, 2nd or 3rd place).
Once you have won a Memorial Award, or received more than 3 placed
awards, you MUST compete in the Group A category for all future
competitions.

Image Evaluations Six times a year, CCR holds an Image Evaluation during our regular monthly
meeting. CCR members (who have paid their Annual Dues) are invited to
submit 1 or 2 images for review. We invite a professional/experienced
photographer or local artist to review these images and provide constructive
feedback to help us learn and improve as photographers.
JPG
JPEG

JPG stands for Joint Photographic Experts Group. JPEG is the standard file
format for compressing digital images so they can be stored or sent by email
more easily. CCR requires that all images submitted for Image Evaluations
and End of Year Competition are in the JPG file format.

Media Type
[D]

In 2020, images must be submitted as Digital Images.
Prints will not be accepted in 2020.
The specific requirements for these submission are contained in:
Digital Submission Rules

Karen Taylor Davis
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Naming
Convention for
EOY Competition

The prescribed way that digital images must be named for the EOY
Competition is so that the hundreds of submissions can be properly sorted
and evaluated. Here is the format:
[Media Type]_[Group]_[Category Abbreviation]_
[Color Designation]_[Title of Image]_[Standard or Wildcard]_
[Your Name]
When you name your digital files:
OMIT the Brackets ([])
INCLUDE the Underscores (_)
INCLUDE any necessary Spaces or Dashes in Your Name and
your Image Title.
For example, this file name:
D_A_AS_L_BW_Double-Crossed_ST_Carol Hagaman.jpg
would represent a
[D]igital Image
in Group [A]
in the [AS]signed Subject [L]oneliness Category
[BW] Black & White Color Designation
Entitled: Double-Crossed
[ST]andard Image (i.e. was previously submitted for Image Evaluation)
By Photographer: Carole Hagaman

Standard Images
[ST]

Standard Images are those images that were submitted for Image
Evaluations during the current year. You are allowed to submit up to 12
Standard Images for the EOY Competition.

Wildcard Images
[WC]

Wildcard Images are those images that were NOT submitted for an Image
Evaluation during the current year. FIVE of the images you submit for the
EOY Competition may be Wildcards. And, yes – you may submit just the five
Wildcard images if you wish. There is no requirement to submit Standard
Images at all.
Back to Table of Contents
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End of Year Groups
Photographers are divided into two Groups for EOY Competition – A and B. This is to allow our
newer members the opportunity to be judged with others of similar skill levels and separately from the
more experienced members as they are first learning the craft.
Group

Description or Group Members

Group A
(Seasoned Exhibitor)

Any member MAY enter images in the Group A competition.
You are REQUIRED to compete in Group A if you have won any
Camera Club of Richmond Memorial Award or have received
more than 3 placed awards (1st, 2nd or 3rd place).
Once you have competed in Group A, you must remain in this
Group for all future competitions.

Group B
(Novice Exhibitor)

Group B is for new/novice CCR Members.
In order to compete in this group, you must NOT have won any
Camera Club of Richmond Memorial Award or have received
more than 3 placed awards (1st, 2nd, or 3rd place).
Once you have won a Memorial Award, or received more than 3
placed awards, you MUST compete in the Group A category for all
future competitions.

Groups will be judged separately, however judging criteria for each Group will be identical.
Back to Table of Contents
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Color Designations
Images may be submitted as either Color Images or Black and White Images.
Color
(C)

Color images are shot in full color or contain any color other than black
and white.

Black & White
(BW)

Black & White images are monochrome images, including infrared
photographs, produced in black and white or in varying tones of only one
color. Images that are primarily monochrome but contain added color to
part of the image should be submitted as Color, NOT as B&W.
Back to Table of Contents

Media Types
In 2020, ALL images must be submitted as Digital Images.
Digital Images
(D)

Digital images must be submitted as .jpg files. Refer to Digital
Submission Rules for specific guidelines on sizing and submitting Digital
Images.

Prints

PRINTS will not be accepted in 2020.

Back to Table of Contents
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Categories
The selection of a Category for your award-winning image can be a daunting task. If you enjoy
surfing the net there are numerous articles, statements, and self-proclaimed authorities who describe,
define, and declare what is right and what is wrong. Nevertheless, this is time-consuming and
confusing at best.
One method, used by pros and amateurs, is to ask yourself a few personal questions about your
motive for capturing that image. For example, was your motive to:
•
•
•
•
•
•
•

Document a historical cathedral? Then, it would fit into Architecture.
Preserve the color and texture of a beautiful blossom? This would be Flora.
Show the magnitude of a vast desert? This would be a Landscape.
Tell a story or show an event? This would be Pictorial.
Capture the beauty or emotion of a particular individual? This is a Portrait.
Shoot that elusive tiger on your African Safari? He would be Wildlife.
Combine multiple images and/or demonstrate your post processing skills? This would be
Creative Art.

If you answer your “motive” question honestly, you will probably select the correct Category.
Our six General Categories will be:
• Architecture
• Flora
• Landscape
• Pictorial
• Portrait
• Wildlife
A seventh, Special Category exists to allow unlimited, creative post-processing edits:
•

Creative Art

At the beginning of each year, the CCR Board announces three special Categories referred to as
“Assigned Subject” Categories for that year. The intent is to challenge our Photographers to try
something new or stretch their post processing skills (since these Categories also allow unlimited,
creative post-processing edits). This year, those Categories are:
• Loneliness
• Places of Worship
• Celebrations

Karen Taylor Davis
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Category Names, Abbreviations, & Descriptions
Architecture
(A)

Architectural photography is the photographing of buildings and similar man-made
structures that are accurate representations of their subjects.

Creative Art
(CA)

Creative Art is an extension of conventional photography and post-processing into creative
art. Its purpose is to stimulate those creative thoughts and encourage experimentation with
new ideas going beyond a simple photograph.

Flora
(F)

Flora photography is a photograph of plant life occurring in a particular region or timeframe.

Landscape
(L)

Landscape photography shows spaces within the world, sometimes vast and unending, but
other times of a smaller scope. Landscape photographs typically capture the presence of
nature (e.g. panoramic views of the Grand Canyon, or a Seascape) with a primary
emphasis on the natural subjects. A Landscape can also focus on man-made features or
disturbances within the natural landscapes (e.g. Richmond Skyline from the Flood Wall, etc)

Portrait
(PO)

Portrait photography is a photograph of a person or group of people that captures the
personality, traits, or faculties of the subject by the use of effective lighting, backdrops,
poses, direction, or post-processing. Street Photographs meeting these criteria may also
qualify as Portraits.

Pictorial
(PI)

Pictorial photography is a general photography category. It might be an image of Still Life, a
Causal Pictorial of a person or pet (not a formal Portrait), Street Photography, Travel
Images, Photojournalism, or any image not previously addressed in another category. This
would be the category for pet photography, whether posed or just spontaneous.

Wildlife
(W)

Wildlife photography traditionally refers to images of undomesticated animal species that
normally live in the wild. Wildlife Photography documents various forms of wildlife in a
natural or simulated habitat. An example of simulated habitat would be an image of a
captive animal in a zoo that does not show cages, buildings, or other man-made
construction not present in its natural surroundings. The incidental presence of animals
(e.g. distant birds, cattle, etc.) or manmade objects (e.g. distant fences, vehicles, etc.) is
acceptable.

Assigned
Subjects

Any image previously submitted to a Monthly Evaluation as an Assigned Subject. The
Assigned Subjects for 2020 are:

(AS_L)
AS_W)
(AS_C)

Loneliness
Places of Worship
Celebrations

Submitted images that do not meet the requirements of the Category
may be disqualified at the judges’ discretion.
Back to Table of Contents
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Submission Criteria
Digital Submission Rules
The Digital Director needs digital files to organize the hundreds of images being judged. In
addition, the CCR Webmaster will create a Member Gallery of all winning images on the CCR
Website and images will be featured on the CCR facebook page and in our monthly publication,
“Southern Exposure”.
You must submit a properly formatted and sized digital image by the general deadline: Midnight
on the 3rd Saturday of October. Here are the specifications:
•
•
•

Digital images must be in jpeg/jpg format.
The longest side of your digital image must not exceed 1920 pixels.
Set your resolution close to 300 to keep file size small and reduce download time.

If necessary, please see separate procedures for:
•
•

Resizing Digital Images in Adobe Lightroom
Resizing Digital Images in Adobe Photoshop

Digital File Naming
Digital images must be properly named so that the hundreds of submissions can be more easily
sorted and evaluated. Be sure to change your digital file name to follow this Naming Convention
when submitting your digital image:
[Media Type]_[Group]_[Category Abbreviation]_[Color Designation]_[Title of Image]_[Standard
or Wildcard]_[Your Name].jpg
OMIT the Brackets ([])
INCLUDE the Underscores (_)
INCLUDE any necessary Spaces or Dashes in Your Name and your Image Title.
For example, this file name:
D_A_L_C_On a Clear Day_WC_Karen Davis.jpg
would represent a
[D]igital Image
Group [A]
[L]andscape Category
[C]olor Image
Entitled: On a Clear Day
[WC] Wild Card (Not previously submitted)
By Photographer: Karen Davis

Karen Taylor Davis
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Digital File Submission Instructions
All digital images must be emailed to the Digital Director by MIDNIGHT on the 3rd Saturday in
October at this address: Digital.CCRVA@gmail.com.
Email your jpg files (2 or 3 at a time) following these guidelines:
To: Digital.CCRVA@gmail.com
Subject: EOY Competition
Click the Paper Clip icon to attach your digital file(s).
Please do not imbed the photo into the body of your email.
You will receive an automated confirmation from the Digital Director’s mailbox. If you have not
received this confirmation by the next day, you should contact him/her to verify that your files were
received.

For Help
If you need help, feel free to contact any of our CCR Directors, starting with:
Digital Director: Digital.CCRVA@gmail.com
Print Director: Prints.CCRVA@gmail.com
a

Back to Table of Contents
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Resizing Images in Adobe Lightroom
Why do I need to resize my images?
CCR Accepts digital images for the following:
•
•
•
•

Image Evaluations at Monthly Meetings
End of Year Competition
Online Member Photo Galleries
Monthly Southern Exposure

All images submitted for any of the above must be as close to and cannot exceed 1920 pixels
on the longest side of that image. Before resizing your image, be sure ALL IMAGE EDITING IS
COMPLETE and you are ready to submit your image.

How do I resize my images in Adobe Lightroom?
Open Lightroom and select the image you want to resize.
Select File > Export. You will see the following screen:

Follow these guidelines for each of the fields:
File Naming
Karen Taylor Davis

Custom Name

This is where you can rename your file according to the
proper Naming Convention.
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Custom Text

Enter your new file name in this box.

Video

No Action

File Settings

Image Format

JPEG

Color Space

sRB

Limit File Size to

N/A

Image Sizing

Output
Sharpening

✓ Resize to Fit

Width & Height

W:
H:

Make sure the longest edge of your image is 1920.
The other dimension will recalculate automatically.

Resolution

300 Pixels per inch

✓ Sharpen for

Screen

Metadata

No Action

Watermarking

No Action

Be sure NOT to watermark your image. Names may not
appear on the front of any image submitted for
evaluation or competition.

Post
Processing

No Action

This is your choice as to whether you want to see the
image once you are done.

Click the Export button. Your file will export to the directory you specified on your computer
and is now ready to email to the Digital Director: Digital.CCRVA@gmail.com.

What if I need help?
If you need help, feel free to contact any of our CCR Directors, starting with:
Digital Director: Digital.CCRVA@gmail.com
Print Director: Prints.CCRVA@gmail.com

Back to Table of Contents
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Resizing Images in Adobe Photoshop
Why do I need to resize my images?
CCR Accepts digital images for the following:
•
•
•
•

Image Evaluations at Monthly Meetings
End of Year Competition
Online Member Photo Galleries
Monthly Southern Exposure

All images submitted for any of the above must be as close to and cannot exceed 1920 pixels
on the longest side of that image and should be under 1 MB (1000K) in size.
Before resizing your image, be sure ALL IMAGE EDITING IS COMPLETE and you are ready to
submit your image for evaluation/judging.

How do I resize my images in Adobe Photoshop?
Open Photoshop.
Select File and choose the image you want to resize.
Select Open and your image will appear.
Select Image > Image Size.
You will see this menu:

Adjust the Pixel Dimensions to 1920 for the longest side:
•
•

Width for a Horizontal Image
Height for a Vertical Image

The other dimension will be calculated automatically.
Karen Taylor Davis
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Resolution: 300 Pixels/Inch.
Click OK.
Your image may appear smaller on your screen.
Select File > Save As and name your file into the proper Naming Convention.
You will then see this window:

Click OK.
Your image will save to the folder you specified on your hard drive and is now ready to email
to the Digital Director: Digital.CCRVA@gmail.com.

What if I need help?
If you need help, feel free to contact any of our CCR Directors, starting with:
Digital Director: Digital.CCRVA@gmail.com
Print Director: Prints.CCRVA@gmail.com

Back to Table of Contents
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End of Year Awards
The maximum number of awards that judges MAY determine for any Group/Category/Type will be a
function of the number of entries in that Group/Category/Type. The winners of these awards will
receive a lovely certificate (suitable for framing!) acknowledging this achievement.
# Entries/Category

* Number of Awards that MAY be given

1-5 Entries

1 Award: 1st Place

6-19 Entries

2 Awards: 1st and 2nd Place

20 – 29 Entries

3 Awards: 1st, 2nd, and 3rd Place

30 – 39 Entries

4 Awards: 1st, 2nd, and 3rd Place, plus 1 Honorable Mention

40 or More Entries

5 Awards: 1st, 2nd, and 3rd Place, plus 2 Honorable Mentions

Assigned Subjects

2 Awards: 1st and 2nd Place

* Awards may not be given to all places in a Category at the judges’ discretion.
Back to Table of Contents

Memorial Awards
The EOY judges will also select six outstanding images for the Camera Club of Richmond’s
Memorial Awards. The winners of these awards will receive trophies (to grace their bookshelves!)
Award:

Name Given to the Award:

Best Color Digital

W.A. Yoder Award

Best B&W Digital

Phillip Luce Award

Best Assigned Subject

Hyman Rose Award

Best in Show

Bernard Howell Award

Back to Table of Contents
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Frequently Asked Questions – AND Answers!
My Question:

The Answer:

Who can enter the End of Year (EOY)
Competition?

Current, paid Camera Club of Richmond (CCR)
Members may enter.

Are there any restrictions on the photos I
enter?

Yes. Refer to the previously stated General Rules.

How many photos may I enter?

Up to twelve (12) images; any combination of prints
and/or digital images.
You are allowed up to FIVE (5) images that have not
been previously evaluated this year (known as
Wildcards).
Any other images (referred to as Standard Images)
must have been evaluated at one of the monthly CCR
Evaluation meetings.

What is a Wildcard Image?

Up to 5 of the images you submit may be Wildcard
images. These images are other photos that have NOT
been evaluated at one of the current year’s Image
Evaluations.

May I submit prints as well as digital images?

Unfortunately, in 2020, only digital images may be
submitted.

If I submitted an image as a print for an
Image Evaluation, may I submit a digital
version of that image for the End of Year
Competition?

Yes, as a special exception for 2020.

What if I want to submit only 5 images - can
they all be Wildcard images?

Yes.

Normally, images must be submitted as the same
Media Type used during the Image Evaluation, but
we are making an exception for 2020, since all EOY
submissions must now be digital.

If you enter between 1 and 5 images, they can all be
Wildcards. There is no minimum requirement for
Standard images.
The reason for the rule is to encourage everyone to
submit images during the year to learn from the
preliminary Image Evaluations.

Do we differentiate images between Color
and Black & White?

Karen Taylor Davis

Yes.
You will enter your images into either the Color or Black
& White Color Designation.
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My Question:

The Answer:

Who determines the Category in which my
images will be judged?

Each photographer assigns the Category to each of
his/her photos based on the Category descriptions.
If you are unsure which Category to select, please
consult with one of the CCR Directors for advice. If the
judges determine that an image does not meet the
criteria for its Category, it may be disqualified.

What happens if I select the “wrong”
Category?

If the judges determine that an image does not meet the
criteria for its Category, it may be disqualified.
To avoid this, if you are unsure which category to select,
please consult with one of the CCR Directors for advice.

May I enter more than one image in a
Category?

Yes.

May I change the title of my Standard
Image?

No.

Is there any exception to the titling rule?

Yes, there is one exception:

There is no restriction on putting multiple images into
one Category. You could put all 12 images into a single
Category if you so choose. (But you would be competing
against yourself!)

The title of a Standard Image must be exactly the same
title used in the Image Evaluation.

An image title may be changed if the Evaluator
specifically suggested a name change.
If you choose to make this change, you MUST notify the
Digital Director with the old and new names.
What are the rules relating to Assigned
Subjects?

Images submitted in an Assigned Subject category,
must have been submitted in that Assigned Subject
category at the Image Evaluation for that subject.

May I enter a Wildcard into an Assigned
Subject Category?

No.

May I incorporate minor adjustments
suggested by an Evaluator into the final
image submitted for EOY Competition?

Yes. Minor adjustments suggested by the Evaluator are
permitted. The revised image must originate from the
same source file.

Karen Taylor Davis

A Wildcard will not be accepted for any of the Assigned
Subject categories. All Assigned Subject images
MUST have been submitted for the Evaluation for that
Assigned Subject.
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My Question:

The Answer:

What other adjustments may I make to my
images?

Images in the six “General” Categories may be
enhanced, but these manipulations must be kept to a
minimum and used only to enhance the existing image
and ensure realism, such as with: levels, exposure, tonal
changes, sharpening, cloning (for minor retouching).
You are free to make any and all adjustments to images
submitted in the “Creative Art” and “Assigned Subject”
Categories.

May I re-submit an image that has been
submitted in a prior, CCR EOY Competition?

Yes.

When is the submission deadline for the
digital version of ALL images?

The EOY Deadline for ALL digital images is usually the
3rd Saturday in October.

You may re-submit an image as long as the image did
not win any awards in a prior, CCR EOY Competition.

The official deadline will be announced once judges are
determined and a date is set for the judging (usually in
early November).
Back to Table of Contents
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